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Disclaimer

The information contained in this document is for general informational purposes only and does
not constitute an offer, solicitation, invitation or recommendation to buy or sell any futures
contracts or other products or to provide any investment advice or service of any kind. This
document is not directed at, and is not intended for distribution to or use by, any person or entity in
any jurisdiction or country where such distribution or use would be contrary to law or regulation or
which would subject Hong Kong Exchanges and Clearing Limited (“HKEX”), Hong Kong Futures
Exchange Limited (“HKFE”) (together, the “Entities”, each an “Entity”), or any of their affiliates, or
any of the companies that they operate, to any registration requirement within such jurisdiction or
country.

No section or clause in this document may be regarded as creating any obligation on the part of
any of the Entities. Rights and obligations with regard to the trading, clearing and settlement of any
futures contracts effected on HKFE shall depend solely on the applicable rules of HKFE and the
relevant clearing house, as well as the applicable laws, rules and regulations of Hong Kong.

Although the information contained in this document is obtained or compiled from sources
believed to be reliable, neither of the Entities guarantees the accuracy, validity, timeliness or
completeness of the information or data for any particular purpose, and the Entities and the
companies that they operate shall not accept any responsibility for, or be liable for, errors,
omissions or other inaccuracies in the information or for the consequences thereof. The
information set out in this document is provided on an “as is” and “as available” basis and may be
amended or changed. It is not a substitute for professional advice which takes account of your
specific circumstances and nothing in this document constitutes legal advice. Neither of the
Entities shall be responsible or liable for any loss or damage, directly or indirectly, arising from the
use of or reliance upon any information provided in this document.

Additional disclaimer for CES China 120 Index Futures

CES China 120 Index (“CES 120 Index”) are calculated and / or disseminated by China Securities
Index Company Limited (“CSIC”) on behalf of China Exchanges Services Company Limited
(“CESC”). Neither CESC nor CSIC guarantee (expressly or impliedly) the accuracy, completeness,
timeliness or fitness for a particular purpose of the CESC Index and/or the information contained
therein; nor do they accept any liability for any damages, loss, costs or expenses suffered by any
person arising from the use of the CESC Index and/or the information contained therein.
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Equity Indices Monthly Performance in March 2023

Sector Indices vs HSI / HSCEI CES120 vs China Theme Indices

Index Name Index Name

CSI 300 Index -1.7%
+5.9%
FTSE A50 Index -2.4%
HS Mainland
MSCI China A 50 Connect Index3.3%

HSI +3.1%
CES120 Index %

HSCEI

i

Equity Index Futures Access Codes %Change % change
Vendor HS Mainland Banks CES 120 HSI HSCEI

Bloomberg BMWA CESA HIA HCA

Refinitiv O#HMBI: O#HCHH: O#HSI: O#HCEL

WIND MBIF CHHF HSIF HHIF

ET Net MBI CHH HSI HHI

Data Source: Bloomberg

As at 31 March 2023
Information for reference only
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Equity Index Futures & Options
Hang Seng Index (HSI) Futures & Options

HSI Products HSI Options (YoY)

HSI Futures (YoY)

Open Interest
(No. of Contracts)

(2023 vs 2022)

Av erage Daily Volume

(No. of Contracts) Open Interest

(No. of Contracts)

Av erage Daily Volume

(No. of Contracts)

280,000 | pmmm ADV (L-Axis) - 200,000 ,000 - ADV (L-Axis) - 400,000
HSI Futures 145,708 (-4%) 127,481 (+12%) 240,000 - Open Interest (R-Axis) Open Interest (R-AXxis)
200,000 - - 150,000 45,000 - - 300,000
160,000 -
B - 100,000 30,000 - - 200,000
Mini-HSI Futures 101,512 (-6%) 12,198 (+3%) 120,000 -
80,000 - - 50,000 15,000 - - 100,000
40,000 -
0 - -0 0 A 0

HSI Options 25,243 (-2%)

Mini-HSI Options 14,598 (+17%)

128,039 (+18%)

18,075 (+34%)

Av erage Daily Volume

HSI Futures (MoM)

Open Interest

N o A 9 N
S S S S S

HSI Options (MoM)

Av erage Daily Volume Open Interest

(No. of Contracts) No. of Contracts
(’\‘2%8‘88%61?5)— ADV (L-Axis) (N?' % Cor:trams) 45,000 - ADV (L-Axis) ( 2 0208: r%o)
Open Interest (R-AXxis) Open Interest (R-Axis)
HSI Futures
+709 1990, ] I - 150,000
Options 4,413 (+70%) 64,274 (+22%) 150,000 g | G 150,000 30,000 ’\/\/\
100,000 - - 100,000 - 100,000
. 15,000 -
HSI VOlatlllty 0 (_) 0 (_) 50,000 - - 50,000 - 50,000
Index Futures
01 0 0 > o >0 0
- - e C -_— m R : S
HSI Dividend %‘2533’2%8282?%
Point Index 166 (+472%) 9,021 (+2710%) 5092 | 5023
Futures

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2023
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Equity Index Futures & Options
HSI Futures & Options

Hang Seng Index HSI vs VHSI Price Level

HSI & Top 5 Constituents

. Includes the largest and most ('000)
Index Description _ ’ . 24 36 160 -
liquid stocks listed in Hong Kong | e—HS|  —\HS| I e HS| Index — Tencent
Index Level 20,400.11 (As at 31 Mar 2023) HS_BC AIA
2 140 A Meituan Baba
Index Volatility (30-Day Historical) | 29.8 22 |
120 -
Index Avg. Day High-Low Range 307.30 (Mar 2023) L o8
. 100 -
HSCE! Correlation (2023) 0.981 20
- 24 80 -
Hang Seng Index Futures 18 20 60
Jan-23 Feb-23  Mar-23 Jan-23 Feb-23 Mar-23

HK$50

Contract Multiplier

Notional Value (1 Contract) HK$1.02Mn (As at 31 Mar 2023)

Call
Transaction Cost* _ gg.g
S 8292
Stamp Duty NA 8 . 26.4
':: o 24.4
Trading Fee HK$10 / contract g & 557
- 2192
SFC Levy HK$0.54 / contract = & g%
2 % 16.2
Commission Rate Negotiable 2 2152
i —14.2
. 13.2
Margin as of 30 Mar 2023 HK$78,150 12.2
10.0

1 2 3 4 5 6
Open Interest (‘000)

0

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2023

X

Distribution of HSI Index Options Ol in Month-end

Put

012 3 456 7 829
Open Interest (‘000)



Equity Index Futures & Options
Hang Seng China Enterprises Index (HSCEI) Futures & Options

HSCEI Futures (YoY) HSCEI Options (YoY)
HSCEI Products or*

ADV
(2023 vs 2022) Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
240,000 - == ADV (L-AXis) - 700,000 120,000 + ADV (L-Axis) r 2,800,000
Open Interest (R-Axi Open Interest (R-AXis)
J - 600,000 i - 2,400,000
HSCEI Futures 196,405 (+7%) 611,302 (+0%)  200:000 [ c00.000 100,000 [ 200,000
160,000 - ! 80,000 - ! !
- 400,000 - 1,600,000
120,000 - 60,000 -
- 300,000 - 1,200,000
Mini HSCEI 80,000 - 40,000 -
Fut SIS 11,369 (-16%) 4,075 (-20%) - 200,000 - 800,000
utures 40,000 - - 100,000 20,000 - - 400,000
0 - 0 0 L e e e e e e 0
N ND O A 9 N g
. ) S S S S S S
HSCEI Options 50,921 (+13%) 1,269,661 (+11%)
HSCEI Futures (MoM) HSCEI Options (MoM)

.. Av erage Daily Volume Open Interest  Average Daily Volume Open Interest
Mln-l HSCEI 4,183 (+20%) 30,308 (+8%) (No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
Options 275,000 | s ADV (L-AxiS) - 700,000 80,000 - ADV (L-Axis) - 2,000,000

Open Interest(R-AXxis)- | Open Interest (R-AXis)
220,000 - 600,000
L 500,000 60,000 - - 1,500,000
HSCEI Futures ¥ '
_ 37,011 (+90%) 939,222 (+27%) 165,000 )| p-! L 400,000
SERE ' 40,000 - - 1,000,000
110,000 - - 300,000 ' o
.. - 200,000
HSCEI Dividend 55,000 - 20,000 - - 500,000
Point Index 1,546 (+14%) 82,325 (+43%) - 100,000
Futures L P —— 0 0 0
5553988 E>cs ool >0caks
<237200 285323858888
2022 2022 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2023
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Equity Index Futures & Options
HSCEI Futures & Options

HSCEI HSI vs HSCEI

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range

Correlation with HSI, CES120 (2023)

Correlation with CSI300, FTSE A50
(2023)

Comprises the largest and
most liquid H shares

6,968.86 (As at 31 Mar 2023)
34.6
117.75 (Mar 2023)

0.981,0.927

0.684,0.679

e H S| em—HSCEI|
100 -
95 -
20 T r . :
1-Mar 8-Mar 15-Mar 22-Mar 29-Mar

HSCEI & Top 5 Constituents

160 1 hscel —— Ping An
Tencent = CCB

140 A Meituan Baba
120 -
100 -

80

60

Jan-23 Feb-23 Mar-23

Contract Multiplier HK$50 Distribution of HSCEI Index Options Ol in Month-end
Notional Value (1 Contract) HK$0.35Mn (As at 31 Mar 2023) Call Put
142 142
125 | gt2s
. L J10.8
Transaction Cost* S108 £ ©
> 94 == © 94
3 T g4
Stamp Duty NA T 8.4 Phe
o 1.4 % 7.4
v
Trading Fee HK$3.5 / contract T 64 s 64
%] = [}
w 5.4 E £54 =
SFC Levy HK$0.54 / contract g 47 | =47
T 42| 42 £
Commission Rate Negotiable 2.0 , , , , , . 20 = i i i X
_ 0 10 20 30 40 50 60 0 20 40 60 80
Margin as of 30 Mar 2023 HK$30,450 Open Interest ('000) Open Interest ('000)

Data Source: HKEX, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2023
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Weekly HSI & HSCEI Options Performance

Contract Multiplier HK$50

Volume
. . Akuna, Eclipse, I-Access, IMC, Maven, ~ (No. of Contracts)
Liquidity Providers ) .
Optiver 30.000 - ® Weekly HSI Options
25 000 m Weekly HSCEI Options
Transaction Cost* 20,000
Stamp Duty N/A 15,000
Trading Fee HK$10 / contract 10,000
SFC Levy HK$0.54 / contract 5,000
- . 0
Commission Rate Negotiable NN NN NN NN DD DDONDONDON® O
AN ORI TONMNIBVWORNS ITNNITIND D O o
o A A NN NNNNNNMM
i Volume
Weekly HSCEI Options e contracts) |
Contract Multiplier HK$50 20,000 - =\\/eekly HSI & HSCEI Options Call
L . Akuna, Eclipse, I-Access, IMC, Mawen, Weekly HSI & HSCEI Options Put
Liquidity Providers ) 16,000 -
Optiver
12,000 -
Transaction Cost* 8,000 -
Stamp Duty N/A 4,000 -
Trading Fee HK$3.5 / contract 0 —_————
LAV QD
SFC Levy HK$0.54 / contract TNOONBO ISR INIITNII
Commission Rate Negotiable

An investment tool to manage short term event risk

Data Source: HKEX
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2023
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Equity Futures & Options
Single Stock Futures & Options

Single Stock Derivatives ADV (2023 vs 2022) _— No. of Single Stock Derivatives

Stock Futures 7,225 (-8%) 32,987 (-3%) Single Stock Futures
Stock Options 665,210 (+13%) 9,973,997 (+29%) Single Stock Options 129
Stock Futures (YoY) Stock Options (YoY) Latest and Future Developments
Av erage Daily Volume Open Interest ~ Average Daily Volume Open Interest
(No. of Contracts) (No. of Contracts)  (No. of Contracts) (No. of Contracts)
12,000 - _/SDV (lL-Axis> | 40,000 800,000 - ADV (L-Axis) B A Stock Futures
10,000 - pen Interest (R-Axis 3 23,888 600,000 Open Interest (R-Axis) | 10,000,000
8,000 - | s ’ - 8,000,000 » Products
25,000
6.000 - . 20000 400,000 - - 6,000,000 > 3 A-shares ETFs futures contracts
4.000 - L 15,000 4,000,000 » Total 98 stock futures contracts
’ 10,000 200,000 1 2,000,000
2,000 (T8 I [ 5000 000,
o L1 o o LLLLARRLIRLLN
NOD O NPT PSR |
DNEE N N R
Stock Futures (MoM) Stock Options (MoM) Stock Options
Av erage Daily Volume Open Interest Average Daily Volume Open Interest * Products .
(No. of Contracts) (No. of Contracts) (No. of Contracts) . (No. of Contracts) » 3 A-shares ETFs 0pt|ons contracts
_ mmmmm ADV (L-Axis) ) 800,000 - ADV (L-Axis) - 12,000,000 -
10,000 Opon Interont (Roaxis) | 50000 Open Interest (R-AX) » Total 129 stock options contracts
8,000 - s - 40,000 ]
I - I 600,000 W - 8,000,000 + Market Makers (MMs)
6,000 1 ¥ 7 39090 00000 | > 3 types of market makers (PMM/ CQMM/
4,000 - 20,000 I QRMM)
200,000 4,000,000 > CQMM to provide 50 series continuous
2,000 - - 10,000 ’ . P
quotations
01 0 0 > >0 0
= csoan c =
283333828582
2022 | 2023

Data Source: HKEX
* Ol compared to previous year-end
Information for reference onlv

As at 31 March 2023
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Hang Seng TECH Index Futures, Options and Futures Options Performance

Hang Seng TECH Index Open Interest (as of 31 March 2023)

index Descriti Tracks the largest technology companies
ndex Description . X Open Interest
listed in Hong Kong (No. of Contracts)
280,000 -~
Hang Seng TECH Index Futures & Options & Futures Options 240.000 -
Contract Multiplier HK$50 per index point 1
Notional Value (1 Contract) HK$215K (As at 31 March 2023) 200,000 1
No. of Liquidity Providers Options: 5 160,000 -
120,000 -
Transaction Cost* 80.000
Stam p Duty NA 3%‘%38’%838%%3
Trading Fee HK$5.00 / contract = < 0 S =
SFC Levy HK$0.54 / contract 2022 | 2023 |

Average Daily Volume (as of March 2023)
A\ .'

(No. of Contracts)

120,000 -
100,000 -
80,000 -
60,000 -
40,000 ~
20,000 -

0 -

2022

Providing investors with a tool to manage their risk exposure

; . Volume and Open Interest continue to growth
to Hong Kong-listed technology companies

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 March 2023
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MSCI China A 50 Connect Index Futures Performance

MSCI China A 50 Connect Index

Balanced representation from 11 sectors

Index Description )
of top 50 China A shares

Index Level 2,196.82 (As at 31 March 2023)
Index Volatility (30-Day Historical) | 20.8

Index Avg. Day High-Low Range 19.52 (March 2023)

CSI300 Correlation (2022) 0.972

FTSE A50 Correlation (2022) 0.982

MSCI China A 50 Connect Index Futures

Contract Multiplier US$25

Notional Value (1 Contract) US$0.05Mn (As at 31 March 2023)
Average Quote Size US$0.27Mn (5 Contracts)

Stamp Duty N/A

Trading Fee US$0.5 / contract

SFC Levy US$0.07 / contract

Margin as of 30 Mar 2023 US$3,110

Sector-balanced exposure to China’s A-share market

Data Source: HKEX
* All calculations are in USD and exclude commission fees
Information for reference onlv

As at 31 March 2023

Average Daily Volume (as of March 2023)

ADV
(No. of Contracts)
20,000 -
15,000
10,000
5,000

0

2022 | 2023 |

Open Interest (as of 31 March 2023)

Open Interest
(No. of Contracts)

30,000 -
25,000 -
20,000 -
15,000 -
10,000 - - -
535395838858
2022 | 2023 |

Risk management tool for diversified China portfolios

11



MSCI Asia and Emerging Market Index Futures Performance

o representation 38 DM and EM countries and
Index Description : o Open Interest
regional indices (No. of Contracts)
100,000 -
MSCI Asia and Emerging Market Index Futures 90.000 -
Contract Multiplier Average US$40 ’
Notional Value (1 Contract) Average US$45K (As at 31 March 2023) 80,000 -
No. of Liquidity Providers 12
70,000 -
Transaction Cost* 60,000
5 > € 5 o 9 89 oz 9olcgc o =
o = O ©
Stamp Duty N/A < g =R 2 % o g 8 g flf <
Trading Fee US$0.6-US$1.0 / contract | |
SFC Levy US$0.07 / contract 2022 2023
Average Daily Volume (As of March 2023)
ADV
(No. of Contracts)
40,000 -
30,000

20,000
10,000

0

2022 2023

HKEX with the broadest suite of MSCI derivatives products

. . . Volume and Open Interest continue to growth
based in the Asian time-zone

Data Source: HKEX
* Exclude commission fees
Information for reference onlv

As at 31 March 2023



MSCI AC Asia ex Japan NTR Index (AxJ) Futures Performance

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEI Correlation (2023)

representation 2 DM countries (excl. Japan)
and 9 EM countries in Asia

491.52 (As at 31 March 2023)
20.4

5.32 (March 2023)

0.909

0.902

MSCI AxJ Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

US$100

US$49K (As at 31 March 2023)
US$0.25Mn (5 Contracts)

0.9 index points (March 2023)

Flow and 11 banks

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Mar 2023

N/A
US$0.5 / contract
US$0.07 / contract

US$2,160

Futures contracts have relatively lower transaction costs

Data Source: HKEX

* All calculations are in USD and exclude commission fees

Information for reference onlv

As at 31 March 2023

Open Interest (31 March 2023)

Open Interest
(No. of Contracts)

1,200 -

1,000 -

800 -

600 -

400 -

200 -
05?§5?%558%%5
< =5 7 < n O =z a|l~> o =
2022 | 2023 |

MSCI AxJ Combines Developed and Emerging Markets (Rebased to 100)

MSCI AxJ -~ MSCI China MSCI HK
130 - MSCISG o MSClInda MSCI Indonesia
----------------- MSCI Korea e MSCI Malaysia MSCI Pakistan
----------------- MSCI Philippines MSCI Taiwan MSCI Thailand
110 ~
90 -
70 T T
Jan-2023 Feb-2023 Mar-2023

MSCI AxJ is a well-established benchmark representing Asia
regional (excluding Japan) equity market performance

13



Hang Seng Mainland Banks Index Futures Performance

Hang Seng Mainland Banks Index (HSMBI)

Index Description

Index Level

Index Volatility (30-Day Historical)
Index Avg. Day High-Low Range
HSI Correlation (2023)

HSCEIl Correlation (2023)

10 largest and most representative
HKEX-listed mainland banks stocks

2,590.15 (As at 31 March 2023)
20.3

29.71 (March 2023)

0.818

0.823

Hang Seng Mainland Banks Index Futures

Contract Multiplier

Notional Value (1 Contract)
Avg. Quote Size

Avg. Bid-Ask Trading Spread

Liquidity Providers

Transaction Cost*

Stamp Duty
Trading Fee
SFC Levy

Margin as of 30 Mar 2023

HK$50

HK$0.13Mn (As at 31 March 2023)
HK$0.65Mn (5 Contracts)

N/A

N/A

N/A
HK$2 / contract
HK$0.54 / contract

HK$6,570

Futures contracts have relatively lower transaction costs

Data Source: HKEX, HSIL, Bloomberg

* All calculations are in HKD and exclude commission fees

Information for reference onlv

As at 31 March 2023

5-Min Avg. Bid-Ask Spreads (31 March 2023)

HSMBI Futures

CEB Bank 6818.HK 0.45%
Minsheng Bank 1988.HK 0.40%

ABC 1288.HK

Bank of China 3988.HK

CITIC Bank 998.HK

PSBC 1658.HK

ICBC 1398.HK

Bankcomm 3328.HK

CCB 939.HK

CM Bank 3968.HK

Index & Constituents 3-Month Performance (Rebased to 100)
=—HSMBI ——CCB (939.HK)

ICBC (1398.HK) BOC (3988.HK)
——ABC (1288.HK)

120 -

90 . .

Jan-2023 Feb-2023 Mar-2023

HSMBI Futures can be used for hedging

14



CES120 Index Futures Performance

CES120 Index 5-Min Avg. Bid-Ask Spreads (31 March 2023)

80 A-Shares and 40 HK-listed Mainland

Index Description
China H-shares, P-chips, and red chips

CES120 Futures | NA

Index Level 5,823.90 (As at 31 March 2023)
Index Volatility (30-Day Historical) | 24.7

Index Avg. Day High-Low Range 69.75 (March 2023)

CSI300 Correlation (2023) 0.868

e csooere aisar [N -
FTSE A50 Correlation (2023) 0.872

0,
p—— CSOP F1SE ASO ETF (282244 — 016
Contract Multiplier HK$50
Notional Value (1 Contract) HK$0.29Mn (As at 31 March 2023)
Average Quote Size HK$1.46Mn (5 Contracts) CES120 & Top Constituents’ 3-Month Performance
(Rebased to 100)

Average Bid-Ask Trading Spread| N/A

130 |e——CES120 Index Tencent CCB
Liquidity Providers N/A ——Ping An ——— China Mobile

120 -
Transaction Cost*

110 -
Stamp Duty N/A
Trading Fee HK$5 / contract 100 - o -
SFC Levy HK$0.54 / contract

1 90 T T
Margin as of 30 Mar 2023 HK$14,550 Jan-2023 Feb-2023 Mar-2023
Futures contracts have relatively lower transaction costs CES120 Futures can be used to hedge A-share positions

Data Source: HKEX, HSIL, Bloomberg
* All calculations are in HKD and exclude commission fees
Information for reference onlv

As at 31 March 2023



Hang Seng TECH Index Futures and Options Access Codes

Information Vendor Hang Seng TECH Index Futures Hang Seng TECH Index Options

AAStocks 221014 322400

ACTIV Financial HTIl/<yy><m>.HF HTIl/<yy><mm>/<strike><t>.HF
Bloomberg L.P. HCTA Index HSTECH Index OMON
Colt Technology HTImy HTI<Strikes>my

DB Power Online HTI HTI

DzZH HTI

East Money HTI

Information

ESunny Information  HTI HTI

ETNet HTI HTI

Hexin Flush HTI HTI

Infocast Ltd HTI HTI

N2N-AFE 870840 873201-7

QianLong 229

Refinitiv O#HHTI O#HTI*.HF

Shanghai Pobo HTI + Month Code

WebStock HTI HTI

Wind HTIF.HK HTIO.HK

Data Source: HKEX

X



MSCI China A 50 Connect Index Futures Access Codes

Information Vendor MSCI China A 50 Connect Index Futures

AAStocks 221790
ACTIV Financial MCA/<yy><m>.HF
Bloomberg L.P. MCYA Index
Colt Technology MCAmy
East Money Information MCA
ESunny Information MCA

ETNet MCA
Infocast Ltd MCA
N2N-AFE 870939
Refinitiv O#HMCA:
SIX Financial MCAmy
Wind MCAF.HK

Data Source: HKEX

X



MSCI Asia and Emerging Market Index Futures Access Codes

MSCI EM Asia |MSCI EM Asia
: MSCI China [MSCI China NTRJex China NTR  |ex Korea NTR MSCI EM EMEA
Information (USD) Index [Connect (USD) (USD) Index |(USD) Index (USD) Index (USD) Index NTR (USD)
Vendor Futures Index Futures Futures Futures Index Futures
Bloomberg HKCA Index  MCYA Index CSIA Index  CJEA Index HQOA Index HQRA Index HRSA Index HQTA Index
Refinitiv 0#HMAN: 0#HMCA: O#HCHI: O#HCHN: 0#HMAC: 0#HMAK: O#HEAN: O#HMEE:
WIND MANF.HK MCAF.HK EANF.HK

MSCI EM ex
Korea NTR
Information (USD) Index
Vendor Futures
Bloomberg HQIA Index HQYA Index
Refinitiv O#HMXK: O#HMEL:
WIND

. MSCI Japan  |[MSCI Japan
Information [NTR (JPY) NTR (USD)
Vendor Index Futures |Index Futures

Bloomberg HQBA Index HJCA Index
Refinitiv 0#HMJJ: 0#HMJU:
WIND MJUF.HK

MSCI
_ Singapore
Information (USD) Index NTR (USD)
Vendor Futures Index Futures
Bloomberg HOBA Index  HKPA Index
Refinitiv O#HMGN: O#HMSN:
WIND

Data Source: HKEX

X

HMPA Index
O#HMEM:

HMOA Index
O#HEMN:

HLCA Index
O#HMHN:

MSCI New
MSCI Malaysia [MSCI Malaysia |Zealand NTR
(USD) Index |NTR (USD) (USD) Index
Futures
HMYA Index  HKEA Index  HOPA Index
0#HMMY: 0#HMMN: O0#HMNZ:
MMNF.HK

MSCI Taiwan
MSCI Taiwan |MSCI Taiwan [25/50 NTR
(USD) Index  [25/50 (USD) (USD) Index
Futures
HJAA Index HRCA Index HRDA Index
O#HMTW: O#HTWP: O#HTWN:
MTWF.HK

MSCI India
NTR (USD)
Index Futures

HJDA Index
O#HMIN:
MINF.HK

HRTA Index
O#HMDA:

MSCI Pacific

ex Japan NTR |[MSCI Pacific
(USD) Index NTR (USD)
Futures Index Futures
HRPA Index HRBA Index
O#HMPJ: O#HMPC:

MSCI Taiwan |MSCI Thailand
NTR (USD) (USD) Index
Index Futures |Futures

HJIBA Index HMTA Index
O#HMWN: O#HMTH:
MWNF.HK

MSCI

Indonesia

Index (USD)

Futures

HMLA Index HKBA Index

O#HMID: O#HMDN:
MDNF.HK

MSCI

Philippines

(USD) Index

Futures Index Futures
HNSA Index HLEA Index
O#HMPH: O#HMPN:

MSCI Thailand |[MSCI Vietnam
NTR (USD) (USD) Index
Index Futures |Futures
HKDA Index HNTA Index
O#HMTN: O#HMVT:
MTNF.HK

MSCI EM ex
China NTR

(USD) Index
Futures

HQDA Index
O#HMXC:

(JPY) Index
Futures

HQAA Index
O#HMJIP:

MSCI
Singapore
Free (SGD)
Index Futures
HKOA Index

0#HMSG:

MSCI Vietham
NTR (USD)
Index Futures

HKSA Index
O#HMVN:
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Weekly HSI and HSCEI Options Access Codes

Hong Kong and International Information Vendors

AASTOCKS 322105 322125

Bloomberg HSI Index OMON HSCEI Index OMON

DB Power HSI HHI

ET Net Limited Menu "Futures/Options" > "Futures/Options Quotation (Short-term)“ > Access code: The series name
Infocast HSI HHI

MegaHub Limited HSI HHI

N2N-AFE 873101 873121

Refinitiv <O#HSIW*.HF> <O#HCEIW*.HF>

Tele-Trend File->Open->Options->HSI File->Open->Options->HHI

MSCI AxJ and MSCI AxJ Futures Access Codes

Hong Kong and International Information Vendors

AASTOCKS - 221495
Activ Financial - MXJ/<yy><m>.HF
Bloomberg M1ASJ Index MJSA Index CT
CQG - MXJ

DB Power - MXJ

East Money Information - MXJ
Factset - MXJE

ICE Data Services - F:MXJ
Infocast - MXJ
N2N-AFE - 870823
QPWeb - P11203

SIX Financial Information - MXJImy
Refinitiv .MIAX00000NUS 0#HMXJ:
Telequote Data - MXJ/<yy><m>.HF
Tele-Trend - MXJFC, MXJmyy

Data Source: HKEX

X
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Sector Index and Sector Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor Mainland Banks
Index

AASTOCKS

Activ Financial =0200700.HK
AFE 837451
Bloomberg HSMBI Index
DB Power

ET Net MBN
Infocast HSMBI
QuotePower SEHK.HHSMBI
Telequote

Refinitiv .HSMBI

Mainland Information Vendors

Information Vendor Mainland
Banks Index

East Money HSMBI

Hexin Flush Financial

Pobo Financial

Qianlong 999905

Wind HSMBI

Data Source: HKEX

X

Mainland Banks
Index Futures

221420
MBI/16K.HF
870809
BMWA Index

MBI
MBI
MBI

P11223

MBImy
0#HMBI:

Mainland Banks
Index Futures

MBI

MBIC

MBI+Month+Year
209

MBIF+yymm+HK
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CES120 Index and CES120 Index Futures Access Codes

Hong Kong and International Information Vendors

Information Vendor | CES 120 Index | CES 120 Index Futures
Bloomberg Finance L.P. CES120 CESA Index DES <GO>
Refinitiv .HKCES120 O#HCHH:
AAStocks.com Limited 110056 221360
AFE Solutions Ltd. 837505 870800

DB Power Online Limited CES120 CHH

ET Net Limited CEC CHH
Infocast Limited CE120 CHH
Interactive Data Group I:CES120 Fn:CHH\MYYDD
Marketprizm Hong Kong Limited CES120 CHHmy
SIX Financial Information Ltd. CES120 CHHmy
Telequote Data International Limited CES120 CHHmy

Mainland Information Vendors

Information Vendor CES 120 Index CES 120 Index Futures

Hithink RoyalFlush Information Network Ltd CES120 CHHC

Shangahai DZH Limited CES120 CHH+Month Code+Year Code
Shanghai Gildata Services Co Ltd CES120 -

Shanghai Wind Information Co., Ltd CES120 CHHF+yymm+.HK
Zheng Zhou Esunny Information Technology Co,

Ltd. } CHH

Shanghai Wenhua Financial Information Ltd - CHHmy

Shanghai Qianlong Advanced Technology Co Ltd CES120 Page 209

Data Source: HKEX

X



